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1. Introduction

1.1 Preface

Elecard Video Quality Estimator is a powerful tool designed for professionals and prosumers in the video
compression field.

Elecard Video Quality Estimator allows the user to calculate objective video quality metrics, such as
PSNR, APSNR, SSIM, DELTA, MSE, MSAD, VQM, NQI, VIF, VMAF and VMAF phone to compare
two streams with referenced RAW data, analyze differences, and identify the code portion causing the
quality change.

1.2 Describing Elecard Video Quality Estimator

The following section defines the specification and features of Elecard Video Quality Estimator.

1.2.1 Supported Video Formats

MPEG-1 Video stream,

MPEG-2 Video stream,

AVC/H.264 Video stream,

HEVC/H.265 Video stream,

VVC/H.266 Video stream,

VP9 Video stream,

AV1 Video stream,

AVS3 Video stream,

MPEG-2 Transport Stream (MPEG-1/2, AVC, HEVC),
MPEG-2 Program Stream (MPEG-1/2, AVC, HEVC),
AV file container (MPEG-1/2, AVC, HEVC),

MP4 file container (MPEG-1/2, AVC, HEVC, VP9, AV1),
MKYV file container (MPEG-1/2, AVC, HEVC, VP9, AV1),
WebM file container based on MKV (VP9, AV1),

IVF file container (VP9, AV1),

FLV file container (AVC, HEVC),

MXF file container.

1.2.2 Supported Raw Formats

1444
1422

YUV

NV12

NV21

P444

RGB24

RGB32

UYVY (Y422, UYNV, HDYC)
V210
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e V400

o V444

e Y42B

e YUY2 (YUNV, V422, YUYV)
o YVI2

e YVI6

e YVYU

1.2.3 Metric Types

e PSNR — Peak Signal-to-Noise Ratio.

e APSNR — average values of PSNR results calculated for a sequence and based on mean values
of MSE results.

e VOM — Video Quality Measurement Techniques — a metric designed to calculate video quality
and measure perceptual effect of video distortions.

e SSIM — Structural SIMilarity. This metric is based on measuring three components (luminance
similarity, contrast similarity and structural similarity) and combining them into result value.

e DELTA — the value of this metric is the mean difference of the color components in the
correspondent points of image.

e MSE — Mean-squired-error based metric.

e  MSAD — the value of this metric is the mean absolute difference of the color components in the
correspondent points of image.

e NQI — New Quality Index - is a metric designed to calculate video quality by combining three
components: correlation loss, luminance and contrast distortion.

e VIF - Visual Information Fidelity - is a full reference image quality assessment index based on
natural scene statistics and the notion of image information extracted by the human visual system.

e VMAF - Video Multimethod Assessment Fusion is an objective full-reference video
quality metric developed by Netflix in cooperation with the University of Southern California.

o VMAF phone — a metric designed to predict the quality of videos displayed on mobile phones.

1.2.4 Features

e Calculation of video quality metrics (PSNR, APSNR, MSAD, MSE, SSIM, DELTA, VQM, NQI,
VIF, VMAF and VMAF phone);

Selection of ROI (region of interest) for metrics calculation;

Display of essential statistics of encoded streams;

Automatic selection of the similar first frame in two streams for analysis synchronization;
Comparison of two encoded frames from different streams with a reference stream;

Sharing comments between application instances and/or applications of Elecard StreamEye Studio
set;

Synchronization between applications of Elecard StreamEye Studio set (Binding mode);

Bit distribution display;

Command line tool;

Saving data into CSV or text files;

Display of comparison results in graphs: quantizer, frame size, bit allocation etc.

www.elecard.com 5
sales@elecard.com


https://en.wikipedia.org/wiki/Video_quality
https://en.wikipedia.org/wiki/Video_quality
https://en.wikipedia.org/wiki/Netflix
https://en.wikipedia.org/wiki/University_of_Southern_California

Elecard Video Quality Estimator 2023 m
UserGuidIe e HH E’EEE,_d

1.3 Using the Guide

1.3.1 Purpose

This guide is intended to help the user utilize Elecard Video Quality Estimator. It describes the Video
Quality Estimator GUI, settings and functions and provides instructions for using Video Quality
Estimator.

1.3.2 Topics Covered

The following lists the topics covered in this document:

e Section 1: Introduction — provides a general overview of Video Quality Estimator and describes
the purpose of the document and its contents.

e Section 2: Getting Started — describes how to install, uninstall and run Video Quality Estimator.

e Section 3: Using Elecard Video Quality Estimator — describes the Video Quality Estimator
GUI, provides instructions for comparing video streams and viewing the results of comparison.

e Section 4: Command Line Tool — covers advantages and features of Command Line Tool, and
describes a list of commands applied for automatic analysis of media streams.

1.3.3 Related Documentation

For additional information, review the following documents:

ISO/IEC 11172-2 for MPEG-1 video

ISO/IEC 13818-2 for MPEG-2 video

ISO/IEC 14496-10 for AVC/H.264 video

ISO/IEC 23008-2 MPEG-H Part 2

ITU-T Recommendation H.265

H.266 Versatile video coding

A VP9 Bitstream Overview for Google VP9

AV1 Bitstream & Decoding Process Specification

AVS3 (Information Technology Intelligent Media Coding (T/AI 109.2 — 2021) by Industry
Alliance Standard)

1.4 System Requirements

1.4.1 Software Requirements

e Ubuntu 18.04/20.04/22.04 LTS x64;
e CentOS 7.6 x86 _64.

1.5 Licensing and Technical Support

By installing, copying, or otherwise using the SOFTWARE PRODUCT or any UPDATES, you agree to
be bound by the terms of the "Elecard" End-User License Agreement ("EULA"). This EULA is a legal
agreement between you (either an individual or a single entity) and Elecard for the "Elecard" software
product(s) accompanying this EULA, which include(s) computer software and may include "online" or
electronic documentation, associated media, and printed materials ("SOFTWARE PRODUCT").

For technical support, please contact Elecard Technical Support Team: tsup@elecard.com
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For sales and licensing information, contact Elecard Sales Department: sales@elecard.com

1.6 Activating Elecard Video Quality Estimator

1.6.1 Sentinel License Protection

Make sure that Sentinel License Manager software has been installed on your computer. License
Manager is provided within the product installation pack for Windows OS and macOS and installed
automatically.

License Manager is provided as a separate installation pack for Linux OS and should be installed
manually.

Please note, Linux OS reinstallation will make the activated product license invalid.

To check that License Manager is properly installed, go to Sentinel Admin Control Center at
http://localhost:1947. If you see your license information, the installation is successfully completed.

gemalto’ Sentinel Admin Control Center

Sentinel Koy
Products
Features

Sevsons

Admin Control Center

Update Anach

Access Log

Configur ation wisler 7 81 80610

Duagrostcs Manager 21 11 4
Inc AJ rights res )

Moo

-
Figure 1. The License Manager with license information

License Manager allows configuring, controlling, monitoring and looking through a list of available
licenses. For more details on License Manager operation click the Help tab.

Note, each page contains the Help tab related to this page only.

You can activate Elecard Video Quality Estimator offline via following steps:

For Elecard Video Quality Estimator activation, a C2V (client-to-vendor) file should be created. To
create the C2V file follow the steps:

1. Open the File tab and select Options in the drop-down menu.

2. A dialog window should open. Open the License tab.

3. Select HASP-SL for PC-based or HASP-HL for dongle-based activation in the Offline activation
with license files field. Note, if you select a PC-based (HASP-SL) activation, full featured
activated Elecard Video Quality Estimator will run only on this particular hardware. If you have
Elecard dongle, plug it into a free USB port on your computer and select dongle-based (HASP-
HL) activation. It will be possible to use Elecard product on any hardware with the dongle
plugged in.

www.elecard.com 7
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Offline activation with license files

| KEY ID = 781922996 TYPE = HASP-HL v

Collect license information

Apply license update

Figure 2. Offline activation with license files

4. Click the Collect license information button. The Save File dialog box should open. Click Save
and save the C2V file to a required directory. Send the saved C2V file to Elecard Sales at
sales@elecard.com.

i Options x

| Main | Visualization | Binding | Save || License |

On-line activation with product key

[

Offline activation with license files

] I Activate J

I KEY ID = 1090240219133363039 TYPE = HASP-5L Y‘

l Collect license information J

l Apply license update J

License message: ready

WwC Decoder [perpetual] [seats: 1 count each: station exportt
AV1 Decoder [perpetual] [seats: 1 count each: station export
VP9 Decoder [perpetual] [seats: 1 count each: station export
Unlimit elements [perpetual] [seats: 1 count each: station ex
MPEG2 Decoder [perpetual] [seats: 1 count each: station exg
HEVC Decoder [perpetual] [seats: 1 count each: station expo
AVC Decoder [perpetual] [seats: 1 count each: station export

4 .
Restore Defaults I Cancel I l oK
Figure 3. Creating a C2V file: License tab

5. After receiving the V2C file containing license information back from Elecard Sales save the
received file to a required directory. Open the File tab and select Options in the drop-down menu
again. Open the License tab and click Apply license update (see Figure 4). The file selection
dialog box should appear. Choose the received V2C file and click OK. Your application is
successfully activated.
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2. Getting Started

The following section details the procedures for installing and running Elecard Video Quality Estimator.

2.1 Installing Elecard Video Quality Estimator

Elecard Video Quality Estimator is supplied as part of Elecard StreamEye Studio or as a standalone
application. The application is installed via Elecard StreamEye Studio or Elecard Video Quality Estimator
installer.

Depending on the purchased product or version, the installation file is located:

e in/opt/Elecard/VideoQuest/bin folder as a separate application;

e in /opt/Elecard/Elecard StreamEye Studio/VideoQuest/bin folder as part of Elecard StreamEye
Studio.
The console is located in /opt/Elecard/VideoQuest/bin folder.

To install Video Quality Estimator on Linux OS, follow the steps below:

e Install the Video Quality Estimator software by running the VideoQualityEstimator-4.x-Linux.deb
file.

e Install Sentinel Runtime (Sentinel License Manager allows using the license).

2.2 Uninstalling Elecard Video Quality Estimator

Elecard Video Quality Estimator can be uninstalled as part of Elecard StreamEye Studio or as a standalone
application

Depending on the operating system, there are two options of uninstalling the application.
1. To delete the Elecard application from Ubuntu:
e Enter the command in the terminal: sudo apt remove <application>;
e  Or using the Ubuntu Software icon:
o When Ubuntu Software opens, click the Installed button at the top.

o Select the application that you want to delete, click Remove and Confirm the
application remove.

o You will be asked to authenticate by entering your password. After authentication
the application will be removed.

2. To delete the Elecard application from CentOS:

e Enter the command in the terminal: sudo yum remove <application>.

2.3 Running Elecard Video Quality Estimator

To run Elecard Video Quality Estimator, click Menu — Applications — Elecard StreamEye Studio — Elecard
Video Quality Estimator.

To run Elecard Video Quality Estimator, click Menu — Applications — Elecard Video Quality Estimator.
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3. Using Elecard Video Quality Estimator

3.1 Introduction

The following section describes Elecard Video Quality Estimator GUI (graphical user interface).

The Elecard Video Quality Estimator program has a simple user-friendly interface that allows the user
to perform a number of operations including: opening 2 encoded streams and 1 raw stream for analysis,
comparison and displaying the results of comparison along with basic parameters of the encoded
streams.

3.2 Describing Elecard Video Quality Estimator

The following section describes Elecard Video Quality Estimator GUI.

Elecard VideoQuest 2022
File View Navigation Help

P
B

size (byte) / encode...
I

bit allocatio
max

96 (38.40%) =
147 (58.80%)

7616/181
66 187 /21

11762/118 =

2120/652 1

2504 528

«
Stream B | Frame “ S(rea&A ‘

BOoy@~yX & B~y @vxs vHEv@~y ££m>~ K 4 b D D A Y (13 4
Stream A B ® | A:bbb_avcts | Diff : Compare B:bbb_hevcits | RAW: bbb.yuv
name value % 2
stream type AVC/H.264
profile High
level 31
chroma format 42:0
resolution 1280 x 720
frame rate 25
coding mode CABAC
declared bitrate undefined
duration 00:00:10:000
frames
count 250
1 7(2.80%) 1

Graphics ®
s v # v PSNR ¥ @ v T I8 + —
Vs(ream frame 227 YUV: A-B [40,242 : 47,567] YUY:,',fo',\W[3?'2?6,5_168'52,8,] YUV: B-RAW [41,393 : 49,33] Bl(AlIo(at{on A;, BitAIIoFation B; gyir!n_zgr_/s;_ Byirln_zgr_a_;_
name value / e
A8 46,175
X adizes] N NN PN e NG N N TN, W e ~— - N e e I i Sy
u 44,915 Y v A st AT X S\ et S NP N s P AN T
v 45,691 4303 v s e v = T2 ‘/
Avg 42,61
Y 41,581 39,865 [ Al T et e TN s
\l/J :2;3;; 183 186 189 192 195 198 201 204 207 210 213 216 219 222 225 228 231 234 237 240 243 246
Avg 42,492 Y] »
Graphics H Comments
N Disp: 249 Diff a:0; b:0; raw:0; Pos: 154x502 & elecard
Figure 4. Elecard Video Quality Estimator GUI — Main Window
3.2.1 ToolBars
The following table describes Elecard Video Quality Estimator toolbars.
Table 1.Elecard Video Quality Estimator GUI - Toolbars
Menu item Button Description
File
Open file = Opens media for analysis.
www.elecard.com 10
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Reopen

Close

Save

Options

Binding

Color space
Scale

Grid

ROI

Output

Difference

Go to begin
Step backward
Play

Step forward

Go to end

x|

x1

= ) @

dl

>
Bl

Opens the recently opened files.

Closes the files.

Allows selecting parameters for saving and saves data:

e stream parameters of the whole file (metrics info, index info, stream info) in a .csv
file (file stores tabular data (numbers and text) in plain text. Each line of the file is a
data record. Each record consists of one or more fields, separated by commas or
semicolon);

e current frame parameters (YUV data and image including A, B, RAW, Difference)
as YUV or .png files.

The saving parameters can be also configured in the Options tab.

Opens the program settings dialog. Allows setting the number of files in a list, selecting

color theme, enabling the delete missing recent files automatically function, and

configuring the saving parameters.

Enables or disables the Binding mode:

e Leader —allows sending comments, commands on interface or positioning
changes to other applications;
o Follower — allows receiving comments, commands from other applications.

View
Selects color space to be displayed: YUV, Y, U, V.

Sets the video scaling coefficient: x0.25, x0.5, x1, x2, x4, x8.
Displays grid for convenience: none, 4x4, 8x8, 16x16, 32x32.

Region of interest (ROI) — limits analysis to the specified field: Normal / Inverse.
Values of ROI: X: -1;Y: -1; W: -1; H: -1.
Output — shows and activates the current window (A / B / RAW / Difference)

Enables/disables the comparison of Streams A and/or B with the Raw stream. The

combo-boxes Difference Mode, Source 0, Source 1 are displayed.

The following Difference modes are available:

e Compare — pixel-by-pixel comparison of two frames. If two pixels are matched, the
result is 0. Otherwise the result is equal to the maximum value.

e Subtraction — pixel-by-pixel subtraction. The result is equal to the difference value.

e Temperature — absolute difference (pixel-by-pixel subtraction), results are
highlighted (black-blue-green-red), where black corresponds to zero difference, blue
corresponds to slight difference, green corresponds to medium difference and red
corresponds to the biggest difference.

e PSNR - the result is the PSNR values (from 0 to 99.99) for corresponding CU
partitioning blocks, where black color corresponds to 0 value, and white color
corresponds to the value of 99.99 and higher.

e PSNR Clip — the same as the PSNR, but minimum result value is the minimal PSNR
among all blocks in the frame and maximum — the maximal PSNR, respectively.
Black color corresponds to minimal value, white color corresponds to maximal
value, and blended colors correspond to intermediate values.

The following Source 0, Source 1 values are available: A, B, Raw.

Navigation

Go to beginning - sets the current position to the first frame in the stream.
Previous - sets the current position to the previous frame.

Play - starts and stops the stream playback.

Next - sets the current position to the next frame.

Go to end - sets the current position to the last frame in the stream.

www.elecard.com
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Offset Offset decrement / increment. Allows adjusting stream position relatively to others.
Decrement /<1 i
Increment
File A Allows choosing between streams: A, B, RAW.
Help
Feedback o Sends the Video Quality Estimator feedback via e-mail with the following subjects:
Submit an Idea, Ask a Question, Report a Bug.
About mm Shows the About window.
Graphics
Barchart il Shows a stream type and frame size: None, Clustered, Overlapping, Bit Allocation,
Configuration Quantizer, Graphics mode.
Graphics | Displays stream graphics: A-B, A-RAW, B-RAW
Visualizes all metric types selected when opening streams in the New Task window:
Metric type PSNR PSNR, APSNR, MSAD, MSE, SSIM, DELTA, VQM, NQI, VIF, VMAF and VMAF
phone. None is displayed when no streams are selected.
Color space ) Selects color space for display: YUV, Y, U, V.
Horizontal 3| Adjusts graphics to the current panel size horizontally.
range
S exticalltAnEe T Adjusts graphics to the current panel size vertically.
Zoom In / Out + ;= Scaling up and down.

3.2.2 Graphics panel

To open the Graphics panel, click the View tab and select Graphics. A dialog window will open.

- .
:
Graphics
Graphics ®
il v [~ » PSNR ¥ @ ¥ T e+ =
stream | frame 174 YUV: A-B [40,242 : 47,5671 YUV: A-RAW [29,865:48,528] YUV: B-RAW [41,393:49,33] Bit Allocation A;  Bit Allocation B; _Qyirl(\_lgr_A_,_ _Qyif:ﬂ_lff_ﬂ_._
name value 49,33
A-B = ;—3,—::.5::,::::,::\ﬁ‘,':zﬁ,:j=_‘i::=‘;.‘j=‘:::==‘:>,:::‘=.=)_<:=:_(::4;_(-'>( e e 2 P 3 £ N s 2 e
¥ 41,739 b . S
u 44915 39,865 e e e = — = < —
v 45,691 174 177 180 183 186 189 192 195 198 201 204 207 210 213 216 219 222 225 228 231 234 237 240 243 246
Avg 4261
=
Figure 5. Elecard Video Quality Estimator GUI — Graphics

The Graphics panel displays the video streams being analyzed. The bar height illustrates the frame size
and the bar color indicates the frame type (red — I, blue — P, green - B). The values displayed above the
graphics correspond to minimum and maximum calculated values for the selected metrics of the
component(-s).

To set the stream position to a frame, click the corresponding bar.

The Bar Chart Configuration button s — ajjows configuring Bar Chart presentation mode to display
additional information about the streams, including: frame size and type, bit allocation and quantizer:

None - is displayed when no configurations are selected.

Clustered — displays chart bars by A-B pairs under the corresponding display number;
Overlapping — displays overlapping (overlaid) chart bars showing variance between them,;

Bit allocation — number of bits that are processed per a unit of time.

Quantizer — displays the frame mean Quantizer value.

Graphics mode — decreases chart bar brightness to focus attention on graphics. This option is
switched on by default.

To select stream graphics between A-B, A-RAW, B-RAW, click the I toolbar button and enable

www.elecard.com 12
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checkboxes.

To see all the metric types selected for graphics displayed, click the Metric type tab "="* ¥ None is
displayed when no metric types are selected.

To choose the component which metrics will be displayed in graphics, click the & button and select the

|&=]

required streams. Click the or £ button to adjust the graphics to the reference window size

horizontally or vertically, the minimal size is 1 pixel per frame. Click the + / — buttons for upscaling
or downscaling the graphics.

Hover a cursor over a frame, the frame metric info is displayed.
Graphics

s * ¥ v PSNR ¥ @ v & K

stream | frame 216

name value -
A-B
Y 41,739
u 44,915
W 45,691
Avg 42,61
A - RAW
¥ 41,581
U 45,077
W 45,739
A 42 492 ot

| Graphics ” Comments |

Figure 6. Elecard Video Quality Estimator GUI — Frame Metric Information Window
3.2.3 Comments Panel

The Comments panel is designed for team work: share comments on a specific frame or group of frames
in the stream, navigation and switching between different instances of the same application or different
applications contained in Elecard StreamEye Studio.

To edit, remove or send comments using the Binding mode, open the context menu by right-clicking.
The Send option enables you to pass the selected comment to the other application of StreamEye Studio
set or the other instance of Video Quality Estimator. To select an application from which messages should

be received or to select a type of messages to be received, go to the Options tab — Binding or see more
details in the Options Dialog section.

Comments

caption
Frame #202 to Alex: check it

Graphics ” Comments |

Figure 7. Elecard Video Quality Estimator GUI — Comments Panel
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3.2.4 Stream Panel

The Stream panel displays the current stream summary information: stream type, profile, compatibility
flags, level, tier, chroma format, resolution, frame rate, declared bitrate, duration, epsnr, frame types,
average frame size, range of quantizer values bit allocation info, frame average bit distribution in CU,
prediction and transformation data.

Stream A [E5]
name value U
stream type HEVC/H.265
profile Main
compatibility Main; Main 10
lewel / tier 3.1/ Main
chroma format 4:2:0
resolution 1280 x 720
frame rate 25.00
declared bitrate undefined
duration 00:00:10:000
frames
count 250
I 7 (2.80%) 1
P 52 (20.80%) |
B 191 (76.40%) ]
size (byte) fenc... 4519/ 305
I 33393/4 L
P 81477169 |
B 24737558 | ]
bit allocation
max 1178 8OO
avg 887 800
min 438 400
qp
qp min 21
qp avg 30.37
qp max 35
distribution (bits)
total 35129 (100.00%) ——
split_cu_flag 1026 (2.92%) 1
cu_skip_flag 1065 (3.03%) 1
prediction
intra_prediction 349 (0.99%)
pred_mode_flag 142 (0.41%)
part_mode 263 (0.75%) |
inter_prediction 0 (0.00%)
transform
rgt_root_chf 607 (1.73%) |
split_transform... 560 (1.60%) |
cbf_cb 666 (1.90%) 1
chf_cr 2278 (6.49%) [ ]
chbf_luma 5395 (15.36%) -
transform 22774 (64.83%) —
Figure 8. Elecard Video Quality Estimator GUI — Stream Panel

3.2.5 Frame Panel

The Frame panel displays the current frame summary information: stream / display number, type, sizes,
qp. If A and B streams are open, information for both streams is displayed simultaneously for better user
experience in analysis and comparison. The red color corresponds to the A stream, the blue color
corresponds to the B stream.
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Frame [
name value A value B | %
streamidisplay 184\1... 185\1...
type B B
size
total 3805 4160 |

intra pred 416 0 |
inter pred 9231 9002 =
transform 12127 20061 mem

qp
avg 31.072 28277
Figure 9. Elecard Video Quality Estimator GUI — Frame Panel

3.2.6 New Task

To open new media files for analysis and comparison, click the = button or click the File tab and select
the corresponding menu item. A dialog window will open.

Add the required streams to the File A, and/or File B and file RAW fields from the Open file dialog
window by clicking the browse button or clicking the recently opened files button. Select the required
parameter for the RAW file in a drop-down box.

Select metrics by enabling the corresponding checkboxes.

Enable checkboxes for ROI (region of interest), auto synchronization and start quality estimation after
closing the dialog, if required. Specify ROI values and choose normal or inverse type of the analyzed
area. Specify the frames range for auto synchronization mode.

Y New task... x
file A:

[Jhomefelecardmesktop!bbb_x265_900kbps.265 152k ~| x|
info : 1280x720 25 -

file B:

[Ihome.felecardmesktopfbbb_xZGS_lS30kbps.265 |EO > x|
info: 1280x720 25

file RAW:

[fhclmefelecardeesktopfbbb.yuv yuv - E_,O X

metrics:

APSMR (Average Peak signal-to-noise ratio)

Delta (Difference of the color components in the correspondent points of image)

MSAD (Absolute difference of the color components in the correspondent points of image)
MSE (Mean Squared Error)

NQI (A Universal Image Quality Index)

PSNR (Peak signal-to-noise ratio)

SSIM (Structural SIMilarity)

VMAF (Video quality assessment based on multi-method fusion)

VMAF (Phore) (Video quality assessment based on multi-method fusion)

VQM (Video quality metric)
use region of interest (x; y; w; h): | -1;-1;-1;-1 normal « |
Use auto synchronization window (frames count): A-B -

[E] start quality estimation after closing this dialog

Cancel

Figure 10. Elecard Video Quality Estimator GUI — New task window

Note: All input files should have the same resolution. If files differ in length, then the shortest length is
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taken for calculation: metrics are not calculated for the frames beyond the shortest file length.

3.2.7 Options Dialog

To configure file settings, binding and saving modes, open the Options dialog by clicking the & button
or selecting the corresponding File menu command, and choose the required tab.

Options X

Main | Visualization | Binding | Save | License

Mumber of recent files in list: 10 I

[T] Delete missing recent files from list automatically
[E show Task dialog when recpen
[E] Always show Property dialog when opening a raw stream

[E] Use the native chroma format in metric calculation

Open With List(name; [path]; [shortcut]):

[] set Position from I Frame
CAUTION: Be aware of the fact that it overwhelmingly causes
improper operation of positioning.

| You can use it only at your own risk and responsibility.

| Restore Defaults | Cancel OK

Figure 11. Elecard Video Quality Estimator GUI — Options — Main Tab
The following table describes the Main tab in the Options dialog.

Table 2. Elecard Video Quality Estimator — Options dialog — Main tab

Control Function
Number of recent files in list Shows a number of recent files being saved in a list.
Delete missing recent files from Allows deleting missing files from the recent list automatically when opening a
list automatically file from the list.
Show Task dialog when reopen Allows reopening the task dialog with previously saved configurations.

Always show Property dialog . . . .
vhen opening a raw stream Allows displaying the Property dialog when opening a raw stream

Use the native chroma format in

metric calculation Allows specifying parser initialization buffer.
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Allows opening the file currently opened in Video Quality Estimator with another

CERG application (see details below).

Allows starting calculation from the first I frame in a stream.

Set position from I frame Note: Be aware of the fact that it overwhelmingly causes improper operation of
positioning. You can use it only at your own risk and responsibility.

The Options Dialog allows opening a file with an external application. To open the file currently opened
in Video Quality Estimator with another application, specify its name and path in the Open with list
field according to parameters specified there. The parameters path and shortcut are optional. If the path
parameter is not specified, default application or player supporting a file format and installed in the
system is opened. Each string specified in the Open with list field corresponds to an individual item in
the menu File — Open with, that allows easy switching between applications or players after configuring
the field.

Note: The Restore Defaults button allows you to reset set options to their original values. Functionality of this button
is not applicable to the License tab.

Options

Main | Visualization | Binding | Save | License

Color Theme: Default -

[E] Use different colors to display output

Restore Defaults Cancel 0K

Figure 12. Elecard Video Quality Estimator GUI — Options — Visualization Tab

The Visualizaion tab allows configuring the display of the application interface. By switching to the
Dark Color Theme, the VideoQuest interface is displayed in the dark mode (by Default the light
background is set). The Use different colors to display output option enables colorization of output values
with different colors in the Frame and Stream panels.
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o Options x

Main | Visualization | Binding | Save | License

Allows exchanging information between applications
contained in Elecard StreamEye Studio.

Localhost Port: 34325

Receive messages from the application:
[E streamEye
[E streamAnalyzer
B videoQuest
B yuvviewer

Messages type to be received from the selected application:
[E Position

positioning in bitstream in different applications but within
the same video file (available only if the same video file is
opened in different applications).
[E comments

allows receiving comments from the selected applications

(available for all selected applications contained in Elecard
StreamEye Studio).

[El GUISynchronization

allows synchronizing the application window size and
switching between internal controls {available for VideoQuest

2021 only)
Restore Defaults l Cancel J l 0K J
Figure 13. Elecard Video Quality Estimator GUI — Options — Binding Tab

The Binding tab contains settings that allow configuration of the interaction between Elecard StreamEye
Studio applications. In the Binding Mode, exchanging information between applications is provided via
a specified port. By activating checkboxes, you can select which applications should send messages and
set messages type that should be communicated. Additionally, the synchronization of applications
window size and switching between controls can be enabled.

www.elecard.com
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W Options X

Main | Visualization | Binding | Save | License

File data type

Decimal separator in .csv file ., ‘

Data delimiter in .csv file Pow

Add distribution info to:
[E) stream Info
[E] Index Info
Add metric info to Index file for:
B ¥ component
| UComponent
] wce mponent

Average Value

Output YUV data type uvy -

Restore Defaults | Cancel l oK

Elecard Video Quality Estimator GUI — Options — Save Tab

The following table describes the Save tab in the Options dialog.

Table 3. Elecard Video Quality Estimator — Options dialog — Save tab

Control

File data type

Decimal separator in .csv file

Data delimiter in .csv file

Add distribution info to

Add metric info to Index file for

Output YUYV data type

3.2.8 Hot Keys

Function

Allows selecting the format in which metrics data should be saved (the CSV or
JSON format).

Allows selecting decimal comma or decimal dot to separate an integer part from a
fractional one of a real number.

Allows selecting comma or semicolon to specify boundaries in data stream.
Allows adding distribution info when saving a file: Stream Info, Index Info.

Allows adding metric info for the selected parameters when saving: Y component,
U component, V component or Average Value.

Allows saving YUV data in one of the following formats: 1444, 1422, IYUV,
NV12,NV21, P444, RGB24, RGB32, UYVY (Y422, UYNV, HDYC), V210,
V400, V444, Y42B, YUY2 (YUNV, V422, YUYV), YVI2,YV16,YVYU.

For tabs, functions and modes switching press hot keys described hereto.

www.elecard.com
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o Ctrl+O —opens a media file.
e Ctrl+R — opens the recently opened file.

The following hot key combinations are used for Navigation:

e Ctrl + Shift + Left  — starts the Go to beginning function.
o Alt+ Left — goes to the Previous frame.

e Ctrl + Space — starts and stops the Play function.

e Alt+ Right — goes to the Next frame.

e Ctrl + Shift + Right — starts the Go to end function.

To change View configuration of panel controls, use the following hot keys:

o F2 — shows / hides all controls.
e F3 — shows all (controls).

For configuring information panels, use the following hot key combinations:

o ALT+I — shows / activates the stream A panel.
o ALTH2 — shows / activates the stream B panel.
o ALTH3 — shows / activates the frame panel.

The following hot keys are used for switching Output Panels:

e CTRL+1 — activates the A panel.

e CTRL+2 — activates the B panel.

e CTRLH3 — activates the RAW panel.

e CTRL+4 — activates the Difference panel.

www.elecard.com
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4. Command line tool

Elecard Video Quality Estimator Command Line tool is designed for insight into MPEG-1/2,
H.264/AVC, H.265/HEVC, H.266/VVC, VP9, AVS3, and AV1 video compression standards and ever
fast quality and compliance check.

Video Quality Estimator Command Line tool allows automatic analysis of video arrays. You can
customize a sequence of commands to perform your specific tasks and automate your routine tasks.
Get to the command prompt by clicking Start->Run and type 'cmd'. Then enter the command to start the
application first and proceed with the command line options. In general, the syntax is as follows:
./videoquest-cli config.xml /inA:input.avc /out:output avc /ref:ref input.yuv

Note: You should not relocate the <product> console without all the other applications of the product
contained in the installation pack, otherwise the console application will not start.

4.1 Configuration File

Configuration file — contains all the commands performed by the application and reflects overall
operation results:

<?xml version="1.0"?>
<VQ version="1">

<inputA file=".." stream="-1(default)" offset="0(default)"/>

<inputB file=".." stream="-1(default)" offset="0(default)"/>
<reference file="" type="IYUV (default)/[*Upsampler Type]"

offset="0 (default)" step="1 (default)"/>

<output separator=". (default)/," delimiter="; (default)/," file=".."/>

<roi x="0" y= "0" width="0" height="0" inverse="true\false"/>
<sync window="0 (default)" source="AB/ARaw/BRaw"/>
<range span="all (default)/start - stop"/>
<info>
<stream distribution="on (default)/off" file="."/>
<index distribution="on (default) /off" file=".."/>
<metrics data="All (default) |AB|ARaw|BRaw"
nativeChroma="Yes (default) /No" component="All (default) |Y|U|V|A"

type="PSNR (default) |APSNR|SSIM|.. " file="."/>
<data source="A|B" format="IYUV (default)/YV12" file=".."/>
<difference type="compare/subtraction/temperature/psnr/psnr clip"
source="AB/ARaw/BRaw" format="IYUV (default)/YV12" file="."/>
<message source="A|B" level="all (default)/message/warning/error"
file=".."/>

</info>

</VQ>

4.2 List of Commands

List of commands contains information on the commands and all parameters, which may be used within
a command, and their description.

Command Description

<inputl/> The tag is used to configure the input file;

<input2/>
Specifies the elementary video stream number, if number of streams exceeds one.
«-1» — first available elementary video stream. It is set by default.
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stream Starting frame for further calculation. Offset from the beginning up to the specified frame in the
stream. It is expressed in frames.
offset
<reference/> The tag is used to configure the reference file;
type Defines the format of the raw data. (YV12 (is set by default) / IYUV are used now. More formats
to be supported in the next updates.);
file Sets the path to the reference file.
offset Offset from the beginning up to the specified frame in a reference stream. It is expressed in
frames. “0” is set by default.
step Coefficient used for calculation of a successive frame number for further analysis. “1” is set by
default.
<output/> The tag is used to configure the output file;
separator Allows selecting decimal comma or decimal dot to separate an integer part from a fractional one
of a real number.
delimiter Allows selecting comma or semicolon to specify boundaries in data stream.
file Sets the output file path.
<roi/> Region of interest selected for measurement;
normal Measures the specified field of the frame;
inverse Measures the whole frame field except the specified part
<sync/> Specifies the frames range for auto synchronization mode. “0” is set by default.
<range/> The tag is used to define the range of analyzed frames;
span Defines the range of frames (all (by default) /start - stop), 'start' - number of the first analyzed
frame, 'stop’ - number of the last analyzed frame.
<stream/> The tag is used to output general information about the analyzed stream;
distribution Contains information on data distribution by type of coding units (on (by default) / off);
file Sets the path for the output stream information.
<index/> The tag is used to output information about frames (offset, frame type, frame size, average
quantizer, etc.);
distribution Contains information on data distribution by type of coding units (on (by default) / off);
file Sets the output file path where information on frames will be saved.
<metrics/> The tag is used to output information on quality metrics;
data Specifies the type of the streams selected for metrics calculation and saving: All (by default) | AB
| ARaw | BRaw;
type Specifies the metric type: PSNR (by default) | APSNR | SSIM | DELTA | MSAD | MSE | VQM |
NQI | VIF| VMAF | VMAF phone.
file Sets the output file path where information on metrics will be saved.
<data/> The tag is used to save output decoder information on any decoding step;
source Defines the type of the source for metrics calculation: A | B | Raw
format Defines the format for saving data (I'YUV (by default));
file Sets the output file path where the data will be saved.
<difference/> The tag is used to output information on difference metrics
type Defines the type of difference (compare/subtraction/temperature/psnr/psnr clip). This is the
required parameter for this tag. Its default value should be set. If the value is not set, this tag will
be skipped;
source Specifies the source type for difference calculation: AB | ARaw | BRaw;
file Sets the output file path where information on difference will be saved.

4.3 Features of Command Line Tool

e Analysis the whole array of video files automatically;
e Addressing specific and complex challenges with a few lines of commands;
e Retrieving submitted results as a text file in CSV format for easy viewing in Excel;
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e Customizing a sequence of commands to perform your specific tasks;
e Accelerating and automating your regular tasks.
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